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1. Introduction 

1.1 Purpose and Scope. 
 
The THEMIS analysis software is derived from an IDL set of routines that operate on CDFs from existing 
missions such as Cluster, Wind, Polar and FAST. This software is being re-organized by the THEMIS 
software developers and scientists, and checked into a software management database—using the freeware 
Subversion (SVN)—for maintenance, tracking updates and contributions by a distributed team, and 
ensuring self-compatibility. In addition to the command-line invoked IDL routines, a graphical user 
interface that prompts the user for opening, analyzing and plotting the THEMIS data is being developed, 
and is intended to facilitate use of the most useful of the THEMIS routines.   

1.2 Applicable Documents. 
1. THM_SYS_012_PDMP    THEMIS Project Data Management Plan 
2. THM_SOC_101_TIME    THEMIS TIME Definition 
3. THM_SOC_108_GMAG_L1_VARNAMES   THEMIS GMAG Variable Name Def’s 
4. THM_SOC_111_SUNSENSPROC   THEMIS SUN SENSOR Science Processing 
5. THM_SOC_112_ATTPAIPROC   THEMIS Science ATT & Inertia Determ. 
6. THM_SOC_113_FGM_CALPROC  THEMIS FGM CAL File and Processing 
7. THM_SOC_114_SCM_CALPROC  THEMIS SCM CAL File and Processing 
8. THM_SOC_115_EFI_CALPROC   THEMIS EFI CAL File and Processing 
9. THM_SOC_116_ESA_CALPROC   THEMIS ESA CAL File and Processing 
10. THM_SOC_117_SST_CALPROC   THEMIS SST CAL File and Processing 
11. SAI-SPEC-1079A (Oct 26, 2005)   THEMIS Coordinate systems  
12. SAI-RPT-0722a (September, 2006)   Probe Alignment Report (MSSS data, p18) 
13. pturin e-mail on Faro alignment results (9/28/06) FGM, SCM mag alignments  
14. THM-MB-MEC-005-Magnetometer clocking r7.pdf  MAG clocking angles 
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2. Brief Overview of the Software 
 
The THEMIS Data Analysis Software (hereafter referred to as THMSW) is IDL-based.  THMSW routines 
can be used to download, open, analyze and plot L1 or L2 data and process L1 data into L2 data quantities.  
There are two main ways to use the programs: with the command line interface, or with the GUI interface. 
 
Future features will include the ability to create L2 data files the L2 data quantities, utility routines to 
translate data into other products (e.g., ascii) as necessary. 

2.1 How to Get Started 
Assuming you have the software installed, the best place to start is with a crib sheet.  The crib sheets in the 
idl/themis/examples folder give end-to-end examples of how to load, process and plot the highest level data 
available for a given instrument. 
 
Crib sheets in idl/themis/examples: 
thm_crib_gmag Crib sheet for GMAG, including wavelet demo. 
thm_crib_mom Crib sheet for particle Moments. 
thm_crib_sst Crib sheet for Solid State Telescope.  
thm_crib_fgm Crib sheet for Flux Gate Magnetometer 
thm_crib_scm Crib sheet for Search Coil Magnetometer – Linux or Windows, only.  
thm_crib_efi Crib sheet for Electric Fields Instrument. 
thm_crib_fbk Crib sheet for Filter Bank. 
thm_crib_scm Crib sheet for Search Coil Magnetometer – Linux or Windows, only.  
thm_crib_asi Crib sheet for loading and displaying All Sky Keogram data. 
thm_crib_tplot Crib sheet for using tplot plotting package, using GMAG data as an example. 
 
You can run any of the crib sheets by typing  
.run <thm_crib_xxx> 
 
when execution stops at a 'stop' command in the crib sheet, type 
.c 
to continue. 
 
Alternatively, you can cut and paste from the crib sheet to the command line. 
 
To find more information on any of the THMSW routines used in the crib sheets, use: 
• The source code of the crib sheets, which is included in the idl/themis/examples directory of the 

software distribution. 
• HTML help included with the software distribution 
• IDL XDOC widget.  At the IDL prompt, type: 

xdoc 
• IDL doc_library procedure.  At the IDL prompt, type: 

doc_library, ‘command_name’  
 
Sample THEMIS routine documentation: 

 
;+ 
;Procedure: THM_LOAD_GMAG, 
; thm_load_gmag, site = site, datatype = datatype, trange = trange, $ 
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;                level = level, verbose = verbose, $ 
;                subtract_average = subtract_average, $ 
;                subtract_median = subtract_median, $ 
;                varname_out = varname_out, $ 
;                subtracted_values = subtracted_values, $ 
;                downloadonly = downloadonly, $ 
;                valid_names = valid_names 
;keywords: 
;  site  = Observatory name, example, thm_load_gmag, site = 'bmls', the 
;          default is 'all', i.e., load all available stations . This 
;          can be an array of strings, e.g., ['bmls', 'ccmv'] or a 
;          single string delimited by spaces, e.g., 'bmls ccnv' 
;  datatype = The type of data to be loaded, for this case, there is only 
;          one option, the default value of 'mag', so this is a 
;          placeholder should there be more that one data type. 'all' 
;          can be passed in also, to get all variables. 
;  TRANGE= (Optional) Time range of interest  (2 element array), if 
;          this is not set, the default is to prompt the user. Note 
;          that if the input time range is not a full day, a full 
;          day's data is loaded 
;  level = the level of the data, the default is 'l2', or level-2 
;          data. A string (e.g., 'l2') or an integer can be used. 'all' 
;          can be passed in also, to get all levels. 
;  /VERBOSE : set to output some useful info 
;  /SUBTRACT_AVERAGE, if set, then the average values are subtracted 
;                     from the loaded variables, 
;  /SUBTRACT_MEDIAN, if set, then the median values are subtracted 
;                     from the loaded variables, 
;  varname_out= a string array containing the tplot variable names for 
;               the loaded data, useful for the following keyword: 
;  subtracted_values = returns N_elements(varname_out) by 3 array 
;                      containing the average or median (or 0) values 
;                      subtracted from the data. 
;  /downloadonly, if  set, then only download the data, do not load it 
;                 into variables. 
;  /valid_names, if set, then this will return the valid site, datatype 
;                and/or level options in named variables, for example, 
; 
;                thm_load_gmag, site = xxx, /valid_names 
; 
;                will return the array of valid sites in the 
;                variable xxx 
;   
;Example: 
;   thm_load_gmag, site = 'bmls', trange = 
;   ['2007-01-22/00:00:00','2007-01-24/00:00:00'] 
; 
;Written by: Davin Larson,   Dec 2006 
; 22-jan-2007, jmm, jimm@ssl.berkeley.edu rewrote argument list, added 
; keywords,  
; 1-feb-2007, jmm, added subtract_median, subtracted_value keywords  
; $LastChangedBy: kenb-mac $ 
; $LastChangedDate: 2007-02-05 22:58:50 -0500 (Mon, 05 Feb 2007) $ 
; $LastChangedRevision: 303 $ 
; $URL: 
svn+ssh://thmsvn@ambrosia.ssl.berkeley.edu/repos/thmsoc/trunk/idl/themis/ground/thm_load_gmag.pro $ 
;- 

2.2 Availability of Code and Documentation. 
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2.2.1 Tested Software Releases 
Zipped and tested code releases along with corresponding documentation are available in release folders 
which can be found at the following URL:  
http://themis.ssl.berkeley.edu/socware 
For example, the latest release as of the writing of this document is in: 
http://themis.ssl.berkeley.edu/socware/thmsw_1_0_20070213/ 
 
Each release folder contains  

• idl folder for browsing the source and documentation. 
• zip file for download of entire contents of the idl folder. 
• doc folder containing the version of this document corresponding to the released software. 

The zip file includes IDL files and HTML documentation.  HTML-browsable documentation of the IDL 
routines is available within each release folder at idl/thmsw_doc.html.   
 

2.2.2 Latest Software Under Development 
The latest THEMIS code being developed and/or integrated at the THEMIS SOC is visible at 
http://themis.ssl.berkeley.edu/socware/bleeding_edge.  The idl subdirectory of bleeding_edge is a link to 
/disks/socware/idl, which is the integration/testing area for the latest data analysis software at UCB SSL.  
There is no guarantee that the software and/or HTML documentation available for browsing is the most up-
to-date version available at any given time.  The /disks/socware/idl workspace can be made up-to-date and 
a snapshot can be created on demand, to allow access to the latest THEMIS software.  The software 
included in these snapshots is made available without warranty or guarantee.  The snapshots will be 
available as zip files within the bleeding_edge folder.  Each snapshot zip file contains the complete set of 
IDL source files and corresponding automatically generated HTML documentation.  The snapshot file 
name corresponds to the SVN revision number and date of the last change that was committed to the 
THEMIS SVN repository at the time the snapshot was made. 
 
Even more up-to-date and detailed access to the THEMIS code will be available through a web interface to 
the SVN repository (read-only) http:// or svn:// URL to be determined.  This is for access to the very latest 
version of the code, plus possibly access to the SVN change log.  
 

2.3 Graphical User Interface 
 
The philosophy of the graphical user interface GUI is to provide a convenient interface to the most 
generally useful capabilities of the command-line THEMIS IDL routines.  General users can use the GUI 
without being required to know the individual IDL routines.  However, users who want a jump -start to 
using the more powerful and customizable IDL programming interface may begin with the GUI and then 
use the GUI to generate a script of the underlying IDL commands which perform the same function.  This 
script can then be used as a starting point for creating an IDL program to process THEMIS data, or can be 
used as a crib sheet for using the THEMIS IDL programming interface. 
 
The GUI code is bundled together with the THEMIS IDL code distribution, they are downloaded and 
installed as a single package. 
 
Documentation for the GUI are found within the software distribution at idl/themis/examples/thm_gui.txt. 
 
In the future, we hope to make the GUI available as an IDL save file runnable on the IDL Virtual Machine. 
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3. User’s Guide 
 

3.1 System Requirements 
The THEMIS Data Analysis Software requires IDL on Windows or a UNIX-like operating system like 
Solaris, Linux, or Mac OS X.  You must have IDL 6.3 to read the THEMIS CDF data files.  Alternatively, 
you can use an earlier version of IDL, and apply the patch available at 
http://cdf.gsfc.nasa.gov/html/idl62_or_earlier_and_cdf3_problems.html 
Even if you have IDL 6.3, you will want to install the patch if you use IDL to write CDF files.  This is  
because of a bug in IDL 6.3 which will be fixed in 6.4. 
 

Mac OS X notes:   
 
You need X11 to view plots and use the GUI in IDL.  You can search for X11 in the Spotlight to 
see if the X11 application is installed on your system.  X11 is available on your Mac installation 
disks, but may not be installed by default.   
 
There is a known problem, mentioned in the IDL 6.3 release notes, which affects all IDL users 
running Mac OS 10.4 (Tiger)  The tlimit command will lock up IDL because the plot window will 
not receive any mouse clicks. 
Workaround: Change the X11 start-up parameters. Do the following: 
1. Open any terminal window (in the X11 application menu bar, you can choose xterm from the 

applications menu) 
2. Enter the following at the shell prompt: 

defaults write com.apple.x11 wm_click_through -bool true   
3. Quit X11 (if it is running). 
The new default will take effect the next time you start X11, and it will persist from that point 
(i.e., you will not have to make the change again). 

.  

3.2 Installation and configuration. 
 
Getting started is usually as simple as of downloading the code and setting up your IDL path, according to 
the instructions, below.  
 
You can download the code from the locations described above in Availabililty of Code and 
Documentation. 
 
Once you've downloaded the zip file, choose a location where you want to place the software directory 
heirarchy. 
 
Unzip the .zip file.  It will create a folder with the same name as the zip file.  The folder will contain an idl 
directory. 
 

3.2.1 IDL PATH setup 

3.2.1.1 IDL PATH Setup on Windows (and IDLDE on UNIX, Linux and Mac) 
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For Windows or IDLDE on UNIX, you can use the File->Preferences widget to set up the path so IDL can 
find the THEMIS IDL files.   
 

UNIX Note: If you use IDLDE on UNIX-like systems, these instructions only work if you do not 
set the IDL_PATH environment variable before you call IDLDE.  If IDLDE does not allow you to 
set the path by following these instructions, then follow the instructions for UNIX installation, 
below. 

 
Start IDL (Windows) or IDLDE (UNIX, Linux, Mac). 
 
Go to File ->Preferences 
Select the ‘Path’ tab. 
 
If <IDL_DEFAULT> is not present, press ‘Insert Standard Libraries’ 
 
Press Insert  
Browse to find your installation and select the ‘idl/external’ directory 
Check the box to indicate “search subdirectories” 
 
Press Insert  
Browse to find your installation and select the ‘idl/ssl_general’ directory 
Check the box to indicate “search subdirectories” 
 
Verify that ‘idl_external’ is last in the list. 
 
Press Insert  
Browse to find your installation and select the ‘idl/themis’ directory 
Check the box to indicate “search subdirectories” 
 

3.2.1.2 IDL PATH Setup for IDL Command Line (UNIX, Linux or Mac OS X) 
For the command line version of IDL, installation consists of setting up the IDL_PATH environment 
variable.  The THEMIS Data Analysis Software distribution includes setup scripts, which help set the 
IDL_PATH variable correctly. 
 
If you use csh or tcsh, the recommendation is to put the following in your .cshrc  
setenv IDL_BASE_DIR /path/to/thmsw_v_sb_yyyymmdd/idl 
source $IDL_BASE_DIR/themis/setup_themis 
 
If you use bash shell, the recommendation is to put the following in your .bashrc (Linux) or .bash_profile 
(Mac) 
IDL_BASE_DIR=/path/to/thmsw_v_sb_yyyymmdd/idl 
. $IDL_BASE_DIR/themis/setup_themis_bash 
 
In the above examples, IDL_BASE_DIR should be set to the full path name to the idl directory inside the 
THEMIS Data Analysis Software release. 
 

3.2.2 Data Directory Setup 
The THEMIS Data Analysis Software requires a local data directory in which THEMIS data files can be 
cached.  The THEMIS will attempt to create the local data directory for you at the following default 
location, depending on your operating system. 
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OS LOCAL_DATA_DIR 
Windows C:\data\themis  
Solaris, Linux, Mac OS X ~/data/themis  
 
These locations should work as-is for most installations; however, if you don’t have administrative 
privileges to create the data directory in the above locations, you can have your system administrator create 
it for you, or you can configure the THEMIS Data Analysis Software to use an alternate location.  See 
Remote Data Access and Local Data Cache for information about configuring an alternate location. 
 

3.3 Software Functions  
This section described the functionality of  the THEMIS software.  The examples are given using the 
command line interface, but the concepts are the same for the GUI. 

3.3.1 Loading THEMIS Data 
The THEMIS software will automatically create a local data cache which mirrors the structure of the 
THEMIS data archive.  The software is written such that the default settings will work for the majority of 
users.  The location of the THEMIS data archive is also found automatically by the software. 
 
To download some data and load it into IDL, you simply specify a timespan and type of data you want to 
load.  If the data does not exist locally on your local_data_dir, it will be downloaded automatically before it 
is loaded into IDL. 
 
At the IDL prompt, type: 
 
timespan, '2006-11-11', 1, /day 
Then, use one of the thm_load commands, e.g. 
 
thm_load_gmag, site='ccnv' 
 
Examples of routines for loading data: 
thm_load_mom loads moments data 
thm_load_efi loads efi waveforms  
thm_load_fgm loads all fgm waveforms (choice of fgl, fgh…) 
thm_load_scm loads SCM waveform. 
thm_load_gmag loads ground mag data for any ground station (by keyword) or all available. 
thm_load_ask Loads All Sky Keogram data for all observatories. 
thm_load_asi Loads All-Sky Imager data for any ground station (by keyword) or all available. 
thm_load_fit Load On-Board Fields Spin-Fit data 
thm_load_fbk Load Filter Bank data 
thm_load_sst Load Solid State Telescope data. 
thm_load_hsk loads housekeeping data – all or one by keyword. Important for FGM 

(temperatures) but also other instruments.  Not implemented yet. 
thm_load_state Loads Orbit and Attitude data 
Standard Load Procedure Keywords:  
SITE string: ground station name, or a list of ground station names, or ‘all’ 
PROBE string: probe name, or a list of probe names, or ‘all’.  e.g. ‘a b c’ 
DATATYPE type of CDF file for the given instrument. 
LEVEL Level of data file to load: 'l1' or 'l2' 
VALID_NAMES Return valid names for DATATYPE, SITE, PROBE, and LEVEL 
VERSION Version of CDF file to load (useful for STATE data): 'v01', 'v02' 
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GET_SUPPORT_DATA Get support data quantities from CDFas well as data quantities. 
CDF_DATA Return a structure containing data and metadata from CDF. 
 

3.3.2 Plot ground or space data 
In the  command line, type  
tplot_names  
to see available data quantities.  Type, e.g., 
tplot, 1 
to plot the first quantity. 
 
tplot, [1,2,3] 
plots a stack plot of the first 3 data quantities. 
 
Plotting routines: 
tplot  General purpose time plotting utility for creating stack plots of waveforms and 

sonograms. 
tlimit Zoom into or out of a tplot 
get_data Get data out of a tplot variable into a structure containing a time tag array and a data 

array. 
store_data Store a data array structure into a tplot variable. 
 
Refer to thm_crib_tplot for examples of using get_data and store_data. 

3.3.3 Calibrations and Beyond 
 
Refer to the crib sheet for each instrument for usage of the calibration routines.  The interface to the various 
calibration routines has not yet been standardized. 
 
Calibration: from L1 data to physical quantities 
thm_cal_mom calibrates all (ESA and SST) moment data 
thm_cal_sst* calibrates SST data provides counts, eflux, flux and psd (phase space density or 

distribution function) data.  *not yet available. 
thm_cal_fit same as thm_cal_sst, above, but for ESA data. 
thm_cal_efi Electric Fields Instrument 
thm_cal_fbk Filter Bank 
... scm ... Software distribution includes FORTRAN executable to calibrate SCM 
 
Beyond calibration: combining physical quantities to create higher level data products:  These routines 
are not implemented yet. 
thm_pa_sst * Combines SST psd, and FGM and provides pitch angles dist. 
thm_pa_esa* same as above, but combines ESA and FGM.  
 

3.3.4 Coordinate Transformations 
 
A coordianate transformation example can be found in thm_crib_fgm.pro.  The coordinate transformation 
routines currently work on tplot variables only. 
 
Coordainate transformation routines include: 
cotrans  Transform between geophysical coordinate systems  
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ssl2dsl Transform between spinning and despun L-vector aligned coordinate system,using 
data from the STATE file. 

dsl2gse Transform between despun L-vector aligned coordinate system and GSE, using data 
from the STATE file. 

3.3.5 Managing Your Data Cache 
There currently exist some experimental routines for managing your THEMIS data file cache.  These 
routines serve as an example of how you will be able to download all data for a given time range with a 
single command. 

• thm_file_download – can be used to download all types of THEMIS data for a given time span. 
• thm_file_cleanup – delete empty directories.  This is a function call.  It searches the hierarchy and 

return files matching a given pattern, sorted by access time.   Currently does not delete files, but 
can be used as a tool for finding old data.   

3.3.6 Configuring Local Data Cache and Remote Access Behavior 
Data locations may be configured at IDL startup (for example, if you want the data to reside in a non-
standard location), or dynamically during an IDL session. 
 
The following table summarizes the controls that can be used, in order of precedence: 

• !THEMIS system variable 
• environment variable settings 
• thm_config.pro  
 

The following table summarizes the settings available: 
!themis structure 
element  

Environment Variable  Description 

local_data_dir THEMIS_DATA_DIR a writable, local directory in which to 
cache data files 

remote_data_dir THEMIS_REMOTE_DATA_DIR URL to a data archive where THEMIS 
data can be found. By default, 
http://sprg.ssl.berkeley.edu/data/themis  

no_download N/A 1: don’t access remote_data_dir 
no_update N/A 0: download only if file on server differs 

or if local file does not exist. 
1: download only if local file does not 
exist. i.e. no clobber. 

progress N/A 0: don’t show progress bar 
1: show progress bar for each file 
downloaded. 

verbose N/A level of verbosity for themis commands, 
0=silent.  Values >1 are generally for 
debugging. 

 

3.3.6.1 Configuration at startup  

For initial configuration, you can set the environment variables specified in the above table.  Depending on 
your operating system and/or shell, this can be done in .bashrc, .cshrc, or ‘System Properties’ Window. 
Alternatively, the thm_config.pro file provides a platform-independent and more flexible way of 
configuring your initial configuration.  



 
 
 
 

 

NAS5-02099 File: thm_soc_120_ANALYSIS_SFW_USERS_GUIDE.doc 4/5/2007 21:04:00 A4/P4  1

1. Make a copy of the idl/themis/common/thm_config.pro in a directory outside the THEMIS Data 
Analysis Software distribution (or edit it in place, if you don’t mind losing your changes when you 
update your software) 

2. Add the directory which contains your copy of thm_config.pro to your IDL PATH, making sure 
that it is before the idl/themis directory.  (See IDL PATH setup, above). 

3. Edit your thm_config file to set the environment variables to your liking.  See the above table for 
the names of relevant environment variables. 

3.3.6.2 On-the-Fly configuration 

The local data directory location can be changed on-the-fly by setting the !themis.local_data_dir system 
variable.  For example, when you are connected to the network, you may choose to use a networked data 
dir: 
!themis.local_data_dir = ‘\\justice\data\themis\’ 
 
The remote_data_dir structure element can also be updated to a different URL. 
 
If you want the software to use only locally available data, and don’t want the software to try to download 
data, you can set: 
!themis.no_download = 1 
 
Note that you can only set the !themis variable in an IDL session after a thm_ command has already been 
run, or after explicitly calling thm_init. 
 

3.4 Graphical User Interface Usage 

 
3.4.1 Getting Started 
 
There are two ways to start the THEMIS GUI. 
 
1 Licensed IDL Installation: start an IDL session. At the IDL prompt, type:  thm_gui,  
2 IDL Virtual Machine (no IDL License required): start the IDL Virtual Machine, select the file: 
thm_gui.sav  *This option is not currently working. 
 
Once you perform either of the above options the widget will pop up: 
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3.4.2 THM_GUI widget definitions 
 
Starting at the top left: 1st column  
 
Choose Start Time button : Pops up a widget that allows you to choose a start time for data to be loaded. 
You may also type a string value of the form yyyy-mm-dd/hh:mm:ss in the window next to the button. 
 
Choose End Time button : Pops up a widget that allows you to choose an end time for data to be loaded. 
You may also type a string value of the form yyyy-mm-dd/hh:mm:ss in the window next to the button. 
 
Loaded Data Box: When data is loaded, information appears in the box, for each datatype loaded, the 
appropriate variable name and time range are listed. To choose a particular data set for plotting, or other 
processing, left-click. Multiple datasets can be selected by holding the "control" key, and clicking more that 
one.  Also, you can click on an option, then hold "shift", and the left mouse button, and drag the cursor over 
the other datasets. 
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User Defined Procedures: In the future we will have the option for the user to define procedures and call 
them from the GUI. Just click on the procedure name and it will run using an IDL CALL_PROCEDURE 
call. 
 
Second Column: 
 
Plot Type: click on "SCREEN" for screen plots. If you click on "PNG" a png plot will be created, with 
filename = "thm_gui_plot_yyyymmddss.png" in your local working directory.  The time stamp on the file 
is the local system time. (Relatively UNTESTED) 
 
Probe: For loading data, Click on "ALL" to load data for all spacecraft, or select individual spacecraft. 
Multiple probes can be selected, using the "control" or "shift" keys, as described for the "loaded Data" list. 
The default value, which is set when the widget is realized, is "ALL". 
 
GMAG Site: For loading data, Click on "ALL" to load data for all sites, or select individual sites. Multiple 
sites can be selected, using the "control" or "shift" keys, as described for the "loaded Data" list. The default 
is "ALL". 
 
ASI Site: For loading data, Click on "ALL" to load data for all sites, or select individual sites. Multiple sites 
can be selected, using the "control" or "shift" keys, as described for the "loaded Data" lis t. The default is 
"ALL". 
 
Third Column:  
 
Data Type: For loading Data, Click on the type of data to load. Multiple datatypes can be selected, using 
the "control" or "shift" keys, as described for the "loaded Data" list. The default datatype, set when the 
widget is realized, is "GMAG": ground magnetometer data. 
 
 
Fourth Column: The BUTTONS 
 
1st group: Data buttons 
 
Load Data: Click on this button to load the selected data. All selected datatypes will be loaded. 
 
Process Data/Tplot: This button will pop up a separate widget with various data processing and plotting 
options, described below. 
 
Delete: Click here to delete the "active" data sets. Note that the "active" data sets can be (1) the data most 
recently loaded, (2) the data most recently processed, plotted, or calibrated, or (3) the data most recently 
selected from the "loaded Data" window. If you want to delete datasets, it’s always best to click on the 
datasets you want to delete. 
 
Show Active Dset: Click here, and the "active" datasets will be denoted in the "loaded Data" window by 
"Active -> " before the variable name. 
 
2nd Group: History buttons 
 
History: Click this to show a record of the IDL commands used to this point. A separate widget will pop up 
that shows the IDL commands, and two buttons. The "save" button will save the history in an IDL source 
file called "thm_gui_yyyymmddss.pro" in your local working directory. The time stamp on the file is the 
local system time.  (Note that there are some issues in the history with respect to typing in time strings, and 
also selection of multiple datatypes, probes, sites, etc...) 
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Clear History: Click this to clear the history. 
 
3rd Group: Calibration buttons 
 
Calibrate EFI: Runs THM_CAL_EFI on any EFI data that is loaded. Note that the EFI data does not have 
to be selected from the "Loaded Data" window. The program will operate on whatever EFI data has been 
loaded. After calibration, the "active" datasets are the calibrated EFI data. 
 
Calibrate FBK, FIT, FGM, MOM: Same as Calibrate EFI for those datatypes. (Calibrate FGM is not yet 
implemented). 
 
4th Group: Summary plots 
 
GMAG Summary Plot: Runs the THM_GMAG_STACKPLOT routine for any loaded GMAG data. This is 
the routine that is used to create the online summary plots. It is intended that there will be a program like 
this for each of the datatypes eventually, and these will be incorporated when they come online. 
 
5th Group:  
 
Help: This button pops up a text widget with the descriptions of the buttons and windows on the widget. 
 
Exit: The exit button kills the widget. Note that it does not touch the tplot common block, so any data 
loaded may still be there. 
 
 

3.4.3 TPLOT Data Processing Widget: 
 

 
 
This widget pops up when you click on the Process Data/Tplot button on the main widget. The first thing 
that will happen is that all of the active datasets are plotted. 
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1st Column: Buttons 
 
Plot It: Plots the active datasets. Note that the other buttons do not automatically replot the data, so if you 
want to see results, click here. 
 
Subtract Average: For each dataset, the average value is subtracted. new variables are created, with the 
syntax: new_var = old_var+"-d", and the new variables become the "active" datasets. 
 
Subtract Median: For each dataset, the median value is subtracted. new variables are created, with the 
syntax: new_var = old_var+"-m", and the new variables become the "active" datasets. 
 
Smooth Data: Boxcar smoothing of the data. A widget will pop up, asking how many data points to smooth 
over. Choose a value, and click on "accept and close". The default is 11 points. New variables will be 
created, with "_sm_npts" appended to the old variable names, where npts is the smoothing resolution. 
 
Time Average: Click this button to average that data over time, a window will pop up, if you want to 
change the time resolution, the default time resolution is 60 seconds. New variables will be created, with 
"_av_tres" appended to the old variable names, where tres is the time resolution. 
 
Clip: Clips data above and below a set maximum and minimum, a widget pops up which allows these 
values to be set. Then data outside the set range is set to NaN.  New variables will be created, with "_clip" 
appended to the old variable names. 
 
Deflag: Interpolates or repeats the most recent valid data value over gaps in the data (gaps are denoted by 
NaNs). A window pops up which is used to set the method, there are two choices: "repeat" will repeat the 
last good value over the gap. "linear" will interpolate over gaps. (Probably the text widget will be replaced 
with buttons.) New variables will be created, with "_deflag" appended to the old variable names. 
 
Clean Spikes: Removes spikes from messy data. New variables will be created, with "_dspk" appended to 
the old variables. 
 
Time derivative: Take the time derivative of the active datasets. New variables will be created, with "d_" 
prepended to the old variable names. 
 
Exit: Exit the widget. 
 
Second column: Plot Options 
 
Ylimit: Set the y limits of the active datasets. A text widget pops up, allowing the limits to be set, and also 
log plotting can be set/unset. (Not exhaustively tested.) 
 
Zlimit: Same as Ylimit, for the Zlimits for spectrogrsm data. (Untested) 
 
Set/Unset Spectrogram: Pops up a text widget. if set to 1, then the active data is set to be plotted as a 
spectrogram, if set to 0, then l ine plots.  (Should be changed to buttons.) 
 
Set Plot Window Size: Pops up a widget for the window size. For screen plots you can just drag the 
window for resizing. The set plot window size window can be used to set the window size for png plots. 
 
Set Plot Window Number: Sets the window number for the screen plots.  
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Tlimit: Calls the tlimit routine, to set time limits using the cursor. Just click twice on the plot to set the time 
limits. 
 
Reset Tlimit: Resets the time limits for the active datasets to the whole time range. 
 
Start time box: The start time limit can be changed in this box.  
 
End time box: The end time limit can be changed in this box. 
 

3.4.4 Example, Load and plot GMAG data 
 
The first step is to load the data, the available data types are listed in the data type window.  Left click on 
the data type that you want to load; multiple data types can be selected by holding the control key while 
clicking. For this example, we will load ground magnetometer data. The default start and end times are in 
the start and end time windows. 
Here we will not reset them, but just load the data for that day. We will load two ground station sites. 
“bmls” and “drby”.(Why not “ccnv”? It had bad data for that day…) 
 
Next we click on the “Load Data” button. Once loaded, the variable names and time ranges appear in the 
“Loaded Data” window.  
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Ok, now we have loaded the data, what next?  We hit the “Process Data/Tplot” button. And a plot window 

will pop up.  
Also another widget pops up. 
 
 

 
 
This allows you to manipulate and plot the data. We cannot tell much from the plot as shown, and we 
suspect that if we normalize the data in some way, we can get a better plot. So we click the “Subtract 
Median” button, and then the “Plot it” Button. 
 
Then, two new variables appear in the “Loaded Data” box on the main window, and these data, which are 
now the “active” data sets, are plotted. 
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The new variables have the same names of the old variables, with “-m” appended.  
 

3.4.5 Example, Load and Calibrate FBK data 
 
Next we will go back and load and calibrate the FBK data for that day. Click on data type “FBK” and probe 
“ALL” (For that day, there is FBK data for probes  “A”, “C” and “E”.) 
Then Click on the “Load Data” button: All sort of new data have been loaded. 
 



 
 
 
 

 

NAS5-02099 File: thm_soc_120_ANALYSIS_SFW_USERS_GUIDE.doc 4/5/2007 21:04:00 A4/P4  2

 
 
To calibrate, click on the “Calibrate FBK” button. Note that you don’t have to click on the FBK datasets in 
the “Loaded Data” window, all available FBK data will be calibrated. 
After this, even more variables are created, but the “active” datasets are the recently calibrated ones. To see 
those, click on the “Show Active Dset” button, and the string “Active ->” will show up in front of the 
active datasets. In this case, the calibrated data are the “th*_fb1”, “_fb2”, “_fbh” data. The original 
uncalibrated datasets, which originally had these names, have now had “_raw” appended to the variable 
names. 
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You can plot the active data now. Click the “Process Data/Tplot” button, and the “TPLOT Data 
Processing” widget will pop up, then click “Plot it”.   
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It doesn’t look like much this  way. Click on the “tha_fb1”, “tha_fb2” and “tha_fbh” variables to reset the 
active data, and plot again. 
 

 
 
Well, it still doesn’t look so great, but it will when there is real flight data…. 
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3.5 General Conventions used in THMSW routines 
 
The naming convention is that all THEMIS-specific routines begin with thm_ followed by the function 
(action) followed by the type of data operated upon. E.g., thm_load_xxx reads xxx data. 
 
Non THEMIS-specific routines have a generic name, such as cotrans. 
 
Some routines operate on (as input and/or output) arrays (or structures of arrays returned by get_data).  
Others operate on tplot variables (i.e. handles to structures which contain data as well as information about 
how to display that data in time plots), while in the future we may upgrade the routines to give an option to 
do either one. 

3.6 Software Organization 
The themis directory contains THEMIS-specific routines.  The general directory (currently named 
ssl_general) contains routines which are useful for more than one space-science mission for which 
THEMIS team members are developing code.  The external directory contains packages developed and 
maintained by other groups, but which are required for writing (and running) the themis and/or general 
routines.   
 
The idl directory of the distribution includes the following files and sub-directories. 
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_thmsw_doc.html Documentation in  HTML format, including alphabetical list of all routines. 

setup_themis  Sample setup script for csh (UNIX) 
ground/ routines for loading, processing and plotting ground-based data.  e.g. 

thm_load_gmag, thm_gmag_stackplot, imageplot, mosaicplot 
fields/ routines for loading, processing and plotting particles 

data, e.g. thm_proc_fgm 
spacecraft/ 

sst/ (Should be particles/)  routines for loading, processing 
and plotting particles data, e.g. thm_load_sst, 
thm_cal_sst 

state/ Routines for reading state and performing coordinate 
transformations, e.g. thm_load_state, cotrans, ssl2dsl, dsl2gse. 

examples/ Crib sheets, like thm_crib_ask 

themis/ 

common/ THEMIS-specific tools useful to multiple data types and instruments, 
eg thm_gui, thm_file_download, thm_init  

CDF/ CDF utilities, including cdf2tplot, and other utilites like cdf2tplot, 
cdf_info, cdf_load_vars (into IDL structure representation of CDF)  

science/ Routines useful for specific scientific analysis. 
cotrans/ Coordinate transformations: Vectorized version of ROCOTLIB. 
tplot/ General time -plotting utilites 
misc/ Miscellaneous routines used by tplot and other ssl_general routines. 

ssl_general/ 
 
 

key_param/  Load routines for ACE, KP, WIND, POLAR data. 
SSW_gen_idl direct import of a portion of SSW general IDL routines external/ 
CDAWeb  

 
The _themis_doc.html file contains a complete listing of all routines in the hierarchy, along with links to 
complete documentation. 
 
 
 

3.7 How to modify code for your own use 
 
This section gives ideas about you can move beyond the generic capability provided by the GUI and crib 
sheets. 
 
For command line-based analysis the process of creating new capability would be  
 

1. Modify code generated  with the thm_gui 'History' feature. 
2. Modify existing analysis crib sheets  
3. Write your own analysis module – an IDL routine -  that operates on data 
4. Transfer between data arrays and tplot variables 
5. Plot the data 

 
You can build on the basic functions of the GUI by: 

 
1. Stringing multiple operations on a pipeline 
2. Creating a new operation and corresponding GUI in your local toolkit (not yet implemented). 
3. Save a pipeline into a crib sheet (transfer to command line based analysis) 

a. Use the History and ‘Clear History’ buttons 
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3.8 How to contribute code and modifications 
If you want to contribute code to the THEMIS IDL SW distribution, you can email us your routines, or you 
can become part of the THEMIS development team and work directly with the SVN repository.  We can 
give you access if you provide us with your SSH public key.  See the THEMIS SOC SW document for 
details on working with the THEMIS SVN repository. 
 


